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I.  Employees: Your First Line of Defense

Protecting classified information depends, today more than ever, on the security 
awareness of employees.   They can literally make or break your security program.  

And the stakes have been raised even higher in the Information Age when an 
employee can hijack or inadvertently disclose secrets at the click of a mouse. 

Today’s threat-driven environment will increasingly play host to a growing 
number of security risks from outlaw hackers, industrial spies and information 
thieves.  So, how do you make sure that government and corporate secrets are 
protected?  The first line of defense is employee awareness — the essential element 
in any successful security program.
 
That’s where your organization and the EMPLOYEE SECURITY CONNECTION 
comes in.  EMPLOYEE SECURITY CONNECTION addresses everyday threats 
and vulnerabilities to information and practical ways to counter them.  It 
demonstrates that your company or agency has a commitment to its security 
program — a policy that encourages employees to take part.  It also provides 
proof-positive evidence to government security inspectors that your company 
takes its security responsibilities seriously.

Under your sponsorship, the EMPLOYEE SECURITY CONNECTION tells your 
employees the reasons behind the rules for protecting classified and proprietary 
information.  It also helps them reduce security risks — both on and off the job.
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II.  Here’s How This Powerful Awareness Tool Works

EMPLOYEE SECURITY CONNECTION gives you the tools you need to convince 
everyone in your organization — from top management to the mailroom — of 
the need to practice good security, day in and day out.  It arms your employees 
with solid advice and information on proven security practices that work.  It 
trains all of your employees to be security-minded, not just for the duration of an 
annual refresher briefing, but all the time!

Issued every three months, this exclusive 8-page awareness newsletter introduces 
your employees to the risks and security responsibilities associated with protecting 
classified and proprietary information . . . and helps them adopt a more security-
conscious mindset.  Each full-color issue is professionally created by our staff of 
security, editorial and design experts.  Every issue comes loaded with practical 
tips, entertaining stories and helpful reminders that keep employees focused on 
security threats and countermeasures.

Flexible, Economical, Easy to Use
You can put EMPLOYEE SECURITY CONNECTION to work in your 
organization immediately and without lengthy preparations.  Best of all, there are 
a variety of ways to use it and get the security message out.

  E-mail copies to your employee distribution list. EMPLOYEE SECURITY 
CONNECTION comes in convenient Adobe PDF format that enables you to 
quickly (and economically!) forward it to  all  your employees.

  Create a “briefing” record.  If you like, request a “return e-mail receipt” from 
employees on your list verifying that they received this quarterly awareness 
“briefing”.  Such a record could come in handy if a breach results in employee 
finger-pointing at you for not keeping them informed about critical security issues.

  Fully customizable.  Place your logo on the front page to underscore 
management support for security.  You can even add your own organization-
specific content to meet your needs. 

  Online access.  Place EMPLOYEE SECURITY CONNECTION on your 
organization’s intranet site where employees can easily access/download at their 
convenience.

  Print and distribute as many copies as needed for your facility.

3.
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III.  What Information Is Covered?

Each quarterly issue of EMPLOYEE SECURITY CONNECTION comes loaded with 
practical tips, entertaining stories and helpful reminders that keep employees focused on 
security threats and countermeasures. Your employees will learn how to take control of 
their security habits and eliminate potentially dangerous security-robbing behaviors.

EMPLOYEE SECURITY CONNECTION addresses all critical security topics that 
employees need to know:

 Security clearance issues and concerns
 NISP security requirements and how they impact employees
 Foreign travel security considerations
 How to recognize and defend against espionage threats 
 Classified material protection responsibilities
 Individual reporting requirements
 How to defend against social engineering attacks
 Information security risks 
 Lessons learned from recent security breaches
 Protection tips for laptops, mobile devices 
 How to defend against insider threats
 Personal security tips at work and at home
 Mini-case studies on security threats and much more…

EMPLOYEE SECURITY CONNECTION helps prevent these top 10 security-
robbing behaviors from undermining your program:

1. 	 Employees taking classified information from the office to work at home.

2. 	 Failure to recognize and report adverse information about a co-worker.

3. 	 Processing classified data on unapproved computer systems.

4. 	 Employee reluctance to challenge unescorted strangers in restricted areas.

5. 	 Business travelers not reporting suspicious contacts or foreign travel.

6. 	 Employees falling for social engineering ploys for sensitive data.

7. 	 Employees hosting onsite visits from foreign nationals without security’s 		

	knowledge.

8. 	 Cleared workers failure to recognize potential approaches from foreign spies.

9. 	 Improper handling and disposal of classified/sensitive data.
10. Workers bringing unauthorized portable devices into work and opening up the 

network to hackers, spies and information thieves.

4.
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IV.  How to Demonstrate Security Awareness ROI

What’s a reasonable investment for deploying a rock solid awareness solution like 
EMPLOYEE SECURITY CONNECTION and satisfying a major requirement of 
the National Industrial Security Program?

Here is a brief Return on Investment (ROI) checklist to help you justify the cost of 
this valuable security awareness service:

Security ROI Checklist

Development Cost:  

How many staff hours would it take to research, write, edit and design a 
professionally produced employee awareness newsletter on your own?

 55 staff hours required to create each quarterly issue x 4 issues = 
220 staff hours per year 

 220 staff hours annually @ $100 per hr (Sal. & Benefits) = $22,000

 Annual cost of Employee Security Connection subscription = $899

 Productivity Savings: $21,101

Keep in mind that a real measurable benefit does not have to be a financial gain. 
It can be lowered staff, improved efficiency, or reduced risk. This is an area where 
outsourcing really pays off.

Delivery Cost:  

The Connection costs only pennies per person per year.

 	  $899 / no. of employees = cost per employee annually

For a typical facility with 1,000 employees, the annual cost to provide this 
continuous awareness program would be a mere .89 cents per employee per 
year — less than the price of a cup of coffee!  And when you factor in how many 
man-hours you save by not incurring downtime for employees to attend security 
awareness briefings, the cost savings and ROI are even greater. 

5.
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Business Costs of Insecurity:

Impress upon decision makers that the true cost of insecurity includes the 
impact of unsatisfactory security inspections caused by lax employee practices 
which could jeopardize both individual and facility security clearances. Even the 
temporary suspension of an individual’s security clearance or a company’s ability 
to bid on classified contracts poses a substantial financial risk. The EMPLOYEE 
SECURITY CONNECTION helps to effectively mitigate this risk.

The business benefits (resulting from security awareness, increased compliance, 
reduced risks and reduced losses through lax employee behaviors) will 
substantially outweigh the costs of this service.

6.
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V.  Steps to Customize Your CONNECTION

Here’s a brief step-by-step tutorial on how to customize your EMPLOYEE            
SECURITY CONNECTION.  The instruction is based on the Adobe Acrobat Help 
Guide and covers: importing your organization’s logo to the front cover, adding 
new text to the document and inserting additional pages with organization specific 
content.

     Also provided is a sample page that you may consider adding to each issue of your 
CONNECTION to address specific announcements, security messages, upcoming 
events like scheduled DSS inspections, results of recent inspections and  your secu-
rity department contact information.  You may also consider creating links to any 
related security policies that are addressed in each issue of the CONNECTION.

Importing Your Organization’s Logo to the Front page of the CONNECTION

Acrobat 6.0 — 8.0 

• 	 Open the document with a Professional version of Acrobat (not the free 

Reader)

• 	 Under the Advanced Editing Tool Bar select the Touch-up Object Tool.

• 	 Go to the File menu and select Open.

• 	 This will bring up a screen to locate the image you want to import.

• 	 The graphic you select will open as a PDF document.

• 	 Select the graphic and copy it.

• 	 Move to the document and page that you want to place the graphic and paste 

it.  You can position the graphic using the Pointer tool.

Acrobat 5.0 — 

• 	 Open the document with a full version of Acrobat (not the free Reader)

• 	 Change the (bottom) Text tool to the Arrow or Pointer tool.

• 	 Go to the File menu and select Open as Adobe PDF.

• 	 This will bring up a screen to locate the image you want to import.

• 	 The graphic you select will open as a PDF document.

• 	 Select the graphic and copy it.

• 	 Move to the document and page that you want to place the graphic and paste 

it.  You can position the graphic using the Pointer tool.
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Adding New Text to the CONNECTION
•	 Choose Tools> Advanced Editing>Touch-Up Text Tool

•	 Ctrl-click (Windows) or Option-click (Mac OS) opens the New Text Font 
dialog box that allows you to select the font and writing mode.

•	 Select the font and writing mode to use, and click OK.

•	 Enter the new text.

Adding a New Page to the CONNECTION

•	 Create the page(s) that you want to insert using MS Word or other page 
layout program.

•	 Save or Export the page(s) to PDF format.

•	 From the Main Acrobat Menu Choose Document

•	 Click on Pages

•	 Select Insert — brings up a screen to locate the document you want to 

insert.
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ANNOUNCEMENTS  

April 17 - 21 — the Defense Security Service 
will conduct an inspection of all aspects of our 
security program.  

May 10 (12:00 – 1:00) — the Public Safety Officer 
from our local police department will conduct a 
workshop on tips and techniques to protect your 
home and automobile from thieves. 

LINKS TO SECURITY POLICIES ADDRESSED 
IN THIS ISSUE

•  Reproduction of Classified Material

•  Creating and Changing Passwords

•  Protecting Proprietary Information

•  Reporting Security Breaches

Security Manager. . . . . . . .  . . . . . . .  Ext: 1234
security.manager@abc.com

Document Control . . . . . . . . . . . . .  Ext: 4387
j.smith@abc.com

Security Administration . . . . . . . . .  Ext: 4394
h.doe@abc.com

Security Organization Contacts

Information Security . . . . . . . . . . .   Ext: 4365
k.jones@abc.com

Plant Protection . . . . . . . . . . . . . . . .  Ext: 4399
s.wilson@abc.com
Parking Control . . . . . . . . . . . . . . . .  Ext: 4726
parking@abc.com

REMINDER

The Security Department will be conducting an 
assessment of all security containers within the 
facility throughout the month of June.  All con-
tainer custodians will be contacted by a Security 
representative to set an appointment for these 
inspections. 

SCAM ALERT

E-Mail Declares IRS ‘Refund Notice’
The Internal Revenue Service has confirmed that 
a widespread phishing e-mail purports to be from 
the IRS.  The e-mail subject line reads, “Refund 
Notice!”  It appears to come from the address 
refund@irs.gov.  Recipients are instructed to click 
on a link in the e-mail to learn whether the IRS 
has received their tax return, and whether their 
refund has been processed.  In reality, the link 
brings victims to a site where they are asked for 
their name, Social Security number, and credit-
card information. As with all phishing e-mails, 
recipients should never click on the link in the 
message, which was created by con artists.

SAMPLE

SAMPLE

(Your Company) 
Security Update
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IV.  Employee Security Connection FAQs

Q. What are my options for distributing the Employee Security Connection?

A. Employee Security Connection comes in convenient Adobe PDF format that 
enables subscribers to easily and economically distribute it to employees.

(1) E-mail copies to your employee distribution list.

(2) Create a “briefing” record. If you like, request a “return e-mail receipt” from 
employees on your list verifying that they received this quarterly awareness 
“briefing”. Such a record could come in handy if a breach results in employee 
finger-pointing at security for not keeping them informed about critical issues.

(3) Intranet. Place Employee Security Connection on your organization’s intranet 
site where employees can easily access/download at their convenience.

(4) Print and distribute as many copies as needed for your facility

Q. Can I customize the newsletter with my organization’s logo?

A. Subscribers may customize their Employee Security Connection by placing 
their corporate/organization logo in the space provided on the front page to 
underscore management support for security. Simple instructions on how to do 
this are provided on page 7.

Q. Do I have the ability to edit/add content to the newsletter?

A. Subscribers may edit the content to best meet their needs. If you wish to 
add specific announcements, security messages or links to your policies and 
procedures you can easily add another page to the Employee Security Connection. 
Simple instructions and a page template are available on page 9.  Subscribers 
typically use this page to announce upcoming inspections, important security 
reminders and Security Department contact information.

Q. What is the publication schedule for Employee Security Connection?

A. The Connection is delivered on a quarterly schedule. Usually the first week of 
January, April, July and October.

10.


